
Helmsman 1.0

a graphic front-end for Second Sight BBSs

by Greg Neagle

August 1, 1991



Contents

Helmsman - Introduction Page 2

Helmsman menus Page 3

Helmsman windows Page 7

Helmsman operation Page 8

Off-line Page 8

Offline replies Page 8

On-line interactive Page 10

AutoPilots Page 13

Chat window Page 16

Error recovery Page 17

Expert information Page 18

Editing BBS files (adding sections) Page 18

Creating new BBS files Page 19

Version history Page 22

Credits Page 23

Helmsman manual- page 2



Helmsman - Introduction

Helmsman is a graphic front-end and off-line reader/replier to Second Sight BBSs.  It was developed 
using SuperCard 1.5, a product of Silicon Beach Software.  

Developing it in the SuperCard environment has several advantages and disadvantages.  The advantages 
are that it was very quick to construct the basic application, especially the visual elements.  It was and 
will be also very easy to make modifications to the application to correct bugs or add features.  The main 
disadvantages are size and speed.  The standalone version of Helmsman is almost 600K uncompressed. 

The other disadvantage, speed, is the major concern, in my view.  It runs sluggishly on a Plus, but 
acceptably on a IIcx, which are the only two machines I've tested it on.  If you use Helmsman on a II-
series machine, you probably won't even notice any slowness.  However, on a Plus, which is what I use 
on a day-to-day basis, its speed can be frustrating at times.  I have done my best to speed it up, and I will 
continue to look for ways to increase the speed.

Helmsman takes the place of a traditional telecommunications program such as Microphone or White 
Knight.   It makes using Maclectic far easier and more "Mac-like" than any traditional telcom program 
ever could.

To use Helmsman, you need to be a registered member of one or more Second Sight BBSs.  
Helmsman will not log you on to a BBS for the first time- to do that, you must use a "standard" 
telecommunications program like ZTerm or White Knight. You need to set your preferences, ask for 
validation and choose combined read sections before you can use Helmsman.  If you have been using a 
Second Sight BBS for some time already, then you should be able to use Helmsman almost at once.

If you are a registered member,  you need to use your regular telcom program to ensure that "Hot Keys" 
are selected as a preference on Maclectic, and to select the message sections you are interested in for the 
combined message read.

WARNING: Since Helmsman is really a SuperCard project, like a HyperCard stack, it modifies itself 
while running.  This leaves open the possibility that an unexpected crash or shutdown could leave the 
application in a corrupted state.  So, before you use Helmsman for the first time, make a backup copy.  
Also, for the same reason, Helmsman runs much faster on a hard disk than on a floppy.  Helmsman will 
not run on a locked volume.

IMPORTANT: When you first use Helmsman, you need to set your modem and BBS settings.  Choose 
Modem settings... from under the Connect menu.  Set the port your modem is connected to and your type 
of phone line (Tone or pulse).  The other two settings- Hayes modem compatibility and Modem set-up 
string should be left alone for now.
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Global settings dialog.

(This is from Helmsman 1.0b5 - Helmsman 1.0 has a slightly different looking dialog.)

Helmsman menus

Apple menu

About Helmsman.. Displays a little info window.

File menu

Open BBS Opens a BBS file.  This gives Helmsman the information 
it needs to communicate with a specific Second Sight BBS.  Each 
BBS requires a different file.  The file is also where mail 
and messages from the BBS can be stored between 
sessions.

You cannot call a BBS until a file has been opened.
Close BBS Closes the current BBS file.

Save selection... Saves any selected text to a file on disk.
Archive messages... Saves all mail and messages to a disk archive.
Restore archive... Loads archived messages back into the mail or message 
window, so you can read and reply to them offline.
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New text Opens the Text Editor window- empty.
Open text... Opens a text file for editing as a message or mail.
Close text Closes the Text Editor window.
Save text... Saves the contents of the Text Editor window to disk.

File menu continued...

New AutoPilot Opens the AutoPilot editor.
Open AutoPilot... Opens an AutoPilot file. (See AutoPilot section for 
details.)
Close AutoPilot Closes the AutoPilot window.
Save AutoPilot... Saves the contents of the AutoPilot window to disk.
Run AutoPilot Executes the current AutoPilot. 

Quit Quits Helmsman.

Edit menu

Undo Doesn't work.  It's there for DAs to use.

Cut
Copy
Paste
Clear All do exactly what you expect on text ONLY.

Edit text... Opens the Text Editor window.
Edit AutoPilot... Opens the AutoPilot window.

Clear buffer Empties the the contents of all windows.

Windows menu

Mail Opens the Mail window or brings it to the front.

Messages
Files
Info
Chat
Text Editor
AutoPilot Same for each of these windows.

Connect menu
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Sign on Calls the current BBS and logs on.  Helmsman will 
automatically redial until it connects.
Sign off Logs off the current BBS.
BBS settings... Opens a dialog where you can set up or change the 
name, password, and speed you use to connect to the BBS.  You also may need to 

modify the phone number used (for example, adding or 
removing a "1-213-" prefix).  These settings can 
and probably will be different for every BBS, and are saved 
with the BBS setup.

BBS Settings dialog.

BBS settings (cont.) The use of the "Expert settings" button is described in the 
"Expert information" section toward the end of the documentation.

Global settings... Opens a dialog that allows you to specify which serial port 
your modem is attached to, what kind of phone line you have (tone or 
pulse), and optionally change the modem initialization 
string.

There is also a check box to indicate 100% Hayes 
modem compatibility.  Leave this box checked unless you get "Modem not 

responding" messages when trying to sign on to a BBS.  
When unchecked, Helmsman bypasses some 
error-checking that does not work on modems that aren't 
100% compatible with Hayes modems.  Your 
modem must be fairly Hayes-compatible, however.
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Global settings (cont.) At the bottom of this dialog is field marked "Message tag 
line."  This is a "sign-off" line or "tag" line that Helmsman automatically 
appends to the end of each message sent by you.  You 
can change this to anything you want; or even delete it 
entirely.  You can use this to automatically sign your name 
at the end of every message, for example.

At the end of the Connect menu is a greyed-out item.  It tells you what BBS is the current BBS.  It will 
show <none> if no BBS is open.

Find menu

Find user name... (Active only when signed on to a BBS)  Finds the correct 
spelling of a user's name.  Useful for addressing mail or 
messages.

Find text... Finds a text string in the top window.
Find again Finds the next occurance of the string.

Macros menu (appears only when signed on to a BBS)

Get mail Gets all private mail addressed to you.
Read all new messages Gets all new messages automatically.
Read your new messages

Gets only the new messages addressed to you.
List new files Searches all file sections for all files uploaded since you 

last called.
Send replies... Automatically posts offline replies.  See Offline replies 
for details.

QuickWords menu (appears only while Chatting or Text Editing)

Configure... This menu is user-configurable.  Choose Configure..., and a 
dialog box will open with the current entries.  Just change them and press 
OK.

Any other item selected from this menu will be auto-typed at the current insertion point.  
Helmsman comes with it pre-configured with some of those sideways faces  like:       :-)     and       >:-(
and a few commonly-used but tedious to type phrases. 
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Change any or all the entries to suit yourself.

Helmsman Windows

(BBS name) This is your "Menu" window.  It presents the BBS 
menus in a graphic format.

Mail All private mail will appear in this window, as well as the 
log-on list of new messages addresed to you.  Buttons at the bottom of 
this window allow you to view the previous and next 
piece of mail, delete mail from the BBS, and reply to 
mail.

Messages All public messages will appear in this window.  
Buttons at the bottom of this window allow you to navigate through the 

messages and make replies.

Files Listings of files available on the BBS appear in this 
window. By highlighting a filename and clicking on the Download button, you can 

download directly from this window.

Info The various on-line information text files of the BBS can 
be displayed here.

Chat This is a mini-terminal emulator within Helmsman. It is 
used to chat with the Sysop, and can also be used to communicate directly with 
the BBS.

Text Editor You edit all your outgoing mail and messages in this 
window.

AutoPilot This is the AutoPilot editor.  See AutoPilot for details.

Helmsman manual- page 8



Helmsman operation

Helmsman has three basic modes of operation.
1) Off-line
2) On-line interactive
3) AutoPilot

Off-line
Off-line operation includes composing messages or mail, reviewing mail, messages, and file 

listings received during an on-line session, and composing AutoPilot sequences.  You can also 
compose replies to mail/messages you are reviewing offline.

Composing messages/mail
Choose "Edit text..." from the Edit menu to create a new message.  Choose "Open text..." from 

the File menu to open a message previously saved or any TEXT-type file.  To save a message for later 
on-line posting, choose "Save text..." from the File menu.

Reviewing mail, messages, and file listings
Use the Windows menu to open the Mail, Messages, Files or Info windows.  You can browse 

through the contents of these windows using the scroll bar and arrow buttons.  Any text you select by 
clicking and dragging can be saved to disk by choosing "Save selection..." from the File menu.  You 
may compose replies to any messages you read while offline.  See Offline replies for details.

Composing an AutoPilot
Choose "Edit AutoPilot..." from the Edit menu to open the AutoPilot window.  AutoPilots are 

described later in this manual.

Offline replies
Offline replies is a powerful feature of Helmsman.  It allows you to capture your messages, log 

off, and easily compose replies offline and easily insert those replies into the proper threads the next 
time you log on.

To use offline replies: after logging off, open the messages window and review your messages.  
You'll notice a new button appears at the bottom of the window: Reply.  If you press this button, you 
will be able to compose an offline reply that is saved to disk in a special file.  All offline replies made 
until you quit, close the current BBS,  or sign on again to the current BBS are saved in the same file.  

Later, when back online, you can use the autopilot or Macros menu to insert these replies into 
the message stream. In the autoPilot, just press "Send replies."  From the Macros menu, select "Send 
replies...".

Using offline replies together with the AutoPilot allows you to use a BBS when you want to, not 
just when it happens not to be busy.  Here's how:

1) Set up an AutoPilot to log on, get all your mail and new messages, then log off.  
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2) Start it running, then go live your life.

3) Come back later.  If Helmsman connected, that is, if the BBS wasn't busy the whole time you were 
gone, your mail will be waiting for you in the Mail window and the new messages will be in the 
Message window.  Open these windows are read them.  If you wish to make a reply to any message, 
simply press the "Reply" button.  For your first reply, a dialog will prompt you for a filename to store 
the replies.  Then the Text Editor will open, and you can compose and "send" your reply as usual.  
When you press "Send," the reply will be written to the reply file.  Keep reading and replying as you 
see fit.

4) Either Quit or choose Clear buffer from the edit menu.

5) When you are ready to call your BBS again, compose an AutoPilot that calls your BBS, gets your 
mail and messages, then sends replies.  When you press the "Send replies" button, you will get a 
dialog asking you to choose the offline reply file.  Choose the file you created in step 3.  Finally, the 
AutoPilot should log off.

6) Start the AutoPilot running.

7) This time, when it connects, not only will it get your mail and messages, but it will insert all the 
replies you made to the previous session.  It will insert them as true replies into the thread of messages, 
if possible.  When the AutoPilot completes,  you can go to steps 3-6 again and again.  You never need 
to call your BBS "live."

If everyone used this approach to using a BBS- the BBS would not be as busy because the time-
consuming process of actually reading messages and composing replies is done offline.  On line time is 
kept to a minimum.

However, if you do call your BBS "live," that is, not using the AutoPilot, you still can send replies that 
you generated while offline.  When the Macros menu is visible on the menu bar, just select "Send 
replies..." from the Macros menu.  You will then choose a reply file and it will be sent.
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On-line interactive
This method of using Helmsman lets you replace the command-line interface of a Second Sight 

BBS with a graphic one - you can click on icons and lists to choose what you want to do: interactively 
reading and posting messages, listing, uploading and downloading files, and even chatting with the 
Sysop if the BBS lets you.

To get started, choose "Open BBS" under the File menu.  Choose a BBS to open.  Then choose 
"Sign on" under the Connect menu.   Helmsman will dial your BBS, and if it is connected, will 
automatically log you on.  It then checks for all new mail or messages addressed to you.  If any are 
found, they are displayed on the first page of the Mail window.  

After you are logged on and the mail check is complete, the main menu window will open. This 
window will bear the name of the BBS.   In the example above, Helmsman is connected to Maclectic, 
a BBS in Whittier, CA.   In this window are several icons, most of which correspond to the major BBS 
departments: Mail, Messages, File Transfers, and Info/News (text).  There are also icons for changing 
your password and calling the Sysop to chat.  (If a particular BBS does not allow you to page the 
Sysop to chat, this button will not appear.) Simply click on any icon to select that item.

Mail
Clicking on the Mail icon in the BBS window takes you to the BBS: Mail window.  Here you 

can choose to send or read mail.

Send mail
Clicking on the Send mail icon opens the Text Editor window.  Just enter your message and 

press "Send."  You can open a previously saved message for further editing or sending by pressing 
"Open...," which lets you choose a TEXT file on disk to open.
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Reading mail
Clicking on any of the Read mail icons opens the Mail window.  Each new message is displayed 

on a screen (card, page) of  its own.  You can get the next message by clicking on the right arrow at the 
bottom of the screen, pressing the right arrow on the keyboard, or pressing return.  You may review 
previous messages by clicking on the left arrow or pressing the left arrow key.  If the Reply or Delete 
buttons are visible, you can reply to the current message or delete it.  Deleting a message deletes it 
from the BBS, but not your screen.

When there are no more messages to be read, the mail window automatically closes.  If you 
wish to stop reading messages before the last one, just click in the close box of the Mail window.

Messages
The message sections operate similarly to the Mail section, with the exception that you must 

choose either a single section or Combined Read before actually reading any messages.
If there are replies to the message you are currently reading, the "Find replies" button will be 

enabled.  Click on it to follow the thread of conversation.  Clicking on "Exit replies" will take you 
back to the sequential flow of messages, and "Show original" will show the first message in a thread of 
replies.

To change your Combined Read setup, hold down the Option key as you click on the 
Combined Read icon.  A dialog will appear.

File Transfers
When you click on the File Transfers icon, a window opens that lets you choose which file 

section you would like to enter.  Click on the appropriate icon, or double-click on the appropriate name 
in the scrolling list.  A new window opens that lets you choose to List all files, List new files, Search 
for files, Upload a file, or Download a file. (Note - some BBSs have certain file sections that you 
cannot upload to.  These are indicated by an asterisk at the end of the file section name.  When you 
enter these sections, the upload button will not appear.)
If you choose to list files, a partial listing will apear on your screen.  Click "More" to continue, or the 
close box to stop.  You can also download files from this screen.  If you select (highlight) a filename 
before clicking the download button, it will automatically appear in the dialog box.  Uploading and 
downloading will prompt you for filenames and destinations, then will attempt to transfer your file.  
Note that no time estimate is given during the file transfer.  Sorry, but I didn't write that routine.  It's an 
XCMD and I don't have the expertise to change it.  

If you know of a newer and/or better file transfer XCMD; especially one that supports ZModem 
transfers, please contact me.  I am always on the lookout for a better file transfer XCMD to use here.
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News/Info (text files)
This lets you view the on-line text files on the BBS.

New Password
This, of course, lets you change your password.

Chat with Sysop
Click on this, and the Sysop will be paged, and the Chat window will open.  See Chat 

window for more.  (Note: some BBSs do not allow you to page the Sysop to chat.  On these BBSs, the 
Chat icon will not appear.)
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AutoPilot window.

AutoPilots

One of the most powerful features of Helmsman is its ability to create AutoPilots.  AutoPilots are lists 
of tasks to be performed automatically.  An AutoPilot can do something as simple as get all private 
mail addressed to you, or as complex as:

1) Wait until a specified time.
2) Dial a BBS repeatedly until a connection is established.
3) Automatically log on.
4) Get all your mail.
5) Get all new public messages.
6) List all new files added since your last call.
7) Send replies generated while offline.
8) Post E-Mail.
9) Post several messages.
10) Download a file.
11) Upload a file. 
12) Log off.
13) Call another BBS and do all of the above again.

All this can be performed without your intervention.

Creating an AutoPilot is simple.  Choose "Edit AutoPilot..." from the Edit menu.  The AutoPilot 
window will open.  It consists of a scrolling field and three rows of buttons.  Each button corresponds 
to an action that the AutoPilot can perform.  Simply press the buttons to build an AutoPilot.

Helmsman manual- page 15



Wait until  prompts you for a time.  It causes the AutoPilot to wait until a specified time before 
continuing.  It was designed to allow you to start an AutoPilot at, say, 10 PM that doesn't even try to 
call until 3 AM.

Call BBS; Sign on  will auto-dial the BBS you choose repeatedly until it connects.  Then it will 
automatically log you on.

Hang up; Sign off logs you off the current BBS.

Get mail  retrieves all mail sent to you.  You have the option of automatically deleting mail as it's 
read, an option I reccomend.

Read new messages retrieves all new messages using the Combined Read function of Second Sight.  
It searches only the message sections that you have set up for Combined Read.  You have the option of 
reading straight through, or following message "threads."

Read your messages retrieves only the new public messages addressed to you.  It ignores all other 
public messages.  This is useful if the BBS has high message traffic, but you are only interested in the 
messages addressed to you. 

IMPORTANT:  The following functions should only be added to an autopilot while the appropriate 
BBS file is open.  Helmsman currently may become confused or even crash if the wrong BBS file is 
open.  In other words, if you are composing an autopilot that downloads a file from the Maclectic file 
sections, you need to have the Maclectic BBS file open BEFORE pressing the "Download a file" 
button in the AutoPilot Editor.

Send E-mail  sends a private message.   You can create the message using the Text Editor window.   

Post a message posts a message to a public message section.  Again, the message should be created 
using the Text Editor.  You also need to specify into which section the message is to be posted.  

Send replies sends an offline reply file.  It will prompt you for the file name, and ask if you wish to 
delete the file after sending it.  See Offline replies for more details.

List new files  searches all the file sections for new files uploaded since your last call.
(Note: this function may not work with some BBSs.)

Download a file  does what it suggests.  You need to enter three things: the name of the file as it 
appears on the BBS, the file section it is in, and then, use the standard file dialog box to choose where 
you want the file saved.
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Upload a file  will upload a file to Maclectic.  Again, a series of dialog boxes will help you enter the 
needed information.  Please use StuffIt or Compact Pro before uploading any file.

Note: your AutoPilot does not have to contain all of these functions.  It also does not have to start with 
Call BBS; Sign on   or end with Hang up; Sign off.   You could call a BBS manually, then transfer 
control to an AutoPilot, or have the AutoPilot call a BBS, then transfer control back to you. 

Run runs the AutoPilot.
Delete erases the last AutoPilot action if you make a mistake.
Clear all  erases the whole AutoPilot so you can start over

Once you have created your AutoPilot, you can save it for later use, or run it now.  To save an 
AutoPilot, just select "Save AutoPilot..." from the File menu.  You can re-open it by choosing "Open 
AutoPilot..." from the File menu.  To run the AutoPilot, select "Run AutoPilot" from the File menu or 
pressing Command-R. Then sit back and watch, or even leave and spend some time with your family!
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Chat window

This is the window through which you chat with the Sysop, if he's available.  Just type your 
comments.  The sysop's comments will also appear in this window.  When you are done chatting, just 
click in the close box at the top of the window.

The chat window is actually a little teminal emulator within Helmsman.  When you open the Chat 
window, either by clicking on "Chat with Sysop" in the main menu window, or by choosing "Chat" 
from the windows menu, you open the Chat window.  Anything you type will be sent to the BBS and 
anything the BBS sends to you will appear in the window. 

What this means is you can use the Chat window to do more than chat.  You can send the BBS 
commands and enter data almost the same way as you would with a regular terminal program.  But 
due to the nature of SuperCard and SuperTalk, it's not fun.  You will find the response slow and erratic.

The major use of this feature is to do things that Helmsman can't- just do them the manual way, as 
though you were using a standard terminal program.  Also, you can sometimes recover from situations 
in which Helmsman gets "out of sync" with the BBS.  Just use the chat window to issue commands to 
return to the BBS's Main Menu.  Then close the chat window.  You should be back in sync.
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Error recovery

Besides using the chat window, there is one other technique you may have to resort to in recovering 
from errors or problems.  If Helmsman "hangs," for example, you may not be able to open the chat 
window to recover.   To get control of the mouse and the menu bar try the following:

1) Some processes, like dialing the BBS, can be interrupted simply by clicking a "Cancel" button.  
These are processes that I "designed" to be interrupted.  If this doesn't work, you can:

2) Press Command-period.  This should give you a dialog box that says "Script stopped by user."  
Click on the "Cancel" button.  This should give you control of the mouse.

3) If a dialog box is left open when you interrupt a script, you may not be able to access the menu bar.  
To close all dialog boxes, press Command-W.  This is the standard "close window" command key.

If you use Command-period to interrupt a script, you may throw Helmsman out of sync with the BBS. 
You should generally open the chat window and use it to return to the Main Menu to insure that you 
are in sync.

Be careful in using these techniques- reserve them for instances in which you cannot get Helmsman to 
respond in any other way.  Interrupting a script while it is writing a file to disk, for example, can leave 
the file corrupted.

Helmsman manual- page 19



Expert information

You can operate Helmsman without knowing anything in the following sections.  However, if you 
want to add or delete message or file sections for a BBS, or even create a new BBS file so you can use 
Helmsman to access another BBS, here's the info you need.

Editing BBS file settings

Helmsman allows you to edit the BBS file settings to keep up with changes on a given BBS.  System 
Operators are always tinkering with their BBSs, adding new sections and deleting less popular 
sections.  You, in turn can edit the BBS file so that Helmsman is aware of new sections, or delete 
references to sections that are no longer available.

To edit the section info, you need to know two things for each new section.  The first is the name of 
the new section EXACTLY as it appears in a message header.  This can and often will be different 
from the section name as it might appear in the BBS's menus.  The second thing you must know is the 
"path" to and from the section.  The "path to"  consists of the keystrokes needed to get to that section 
from the main menu, and the "path from" consists of the keystrokes required to get back to the main 
menu from the section.

For example, to get to the "Apple Gossip" section on Maclectic, from the main menu you must type P, 
then A.  So the "path to" is "PA".  To get back to the main menu, you simply type an "E".  That is the 
"path from."

Now for the editing.  Select "BBS Settings..." from the Connect menu.  Click on the "Expert settings" 
button.   A window will open with BBS global settings.  Do not change these.  Click on the "More 
expert settings" button.  The next window will contain listings for message, info/text, and file sections. 
To delete a section, simply delete it from the appropriate list.  To add a section, add it to the list.  To 
use the example above, you would add "Apple Gossip,PA,E" to the list.  No spaces are necessary 
between the items, and are not recommended.  

If you add a file section, note that an asterisk at the end of the section name indicates that you cannot 
upload to that section.  You must add the asterisk if appropriate.
When you are done adding and deleting items, click on "Save changes".

Besides adding or deleting sections, you can also rearrange the order sections appear in the various 
Helmsman dialogs but reordering them here.  You might want to alphabetize them, for example.
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Creating new BBS files

Obviously, since the important BBS parameters can be edited, it is also possible to create a BBS file 
for additional BBSs.  However, to do so will require some careful research on your part.   Not only do 
you need to determine the names and paths of every message, file and text section, but you also have 
to determine every parameter required in the first Expert Settings window.

Don't even attempt this unless you have used the BBS in question via a "normal" telecommunications 
program for a while.  The method I use is to log on to the BBS with ZTerm, visit every section and 
menu choice; then print the whole scroll-back buffer out on paper to refer to while editing/creating the 
BBS file.
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The best procedure to follow is to duplicate an existing BBS file from the Finder, and rename it to the 
name of your new BBS.  Open it with Helmsman.
Next choose "BBS Settings" from the Connect menu, and click on "Expert settings" to open the first 
expert settings window.  You then need to enter or edit every field on this screen.

BBS Name should be obvious.
Main menu prompt  should be the last four or five characters of the prompt that appears at the bottom 
of the main menu screen.
E-Mail path is the sequence of keystrokes required to get to the E-Mail menu from the main menu.
E-Mail exit is the sequence of keystrokes requires to get back to the main menu.
New password path is the path of keystrokes to get to the dialog in which you can change your 
password.
Chat path - the keystrokes needed to page the Sysop.  If this is not supported on a given BBS, insert 
"<none>" here.
Combined read path - the keystrokes needed to get to the combined read dialog.
Combined read exit - how to get back to the main menu.
Comb. read edit path/Comb. read edit exit - you guessed it; the sequence of characters you type to 
get to the dialog that allows you to choose messages sections for combined read.
Logoff path is of course, the key(s) you type at the main menu to log off.

Main menu begin line is a unique series of characters in the very first line of the BBS's main menu.  
Make sure that these characters do not appear in this sequence at any time from the log on until the 
main menu appears.
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Msgs renumber? (Y/N) is a simple yes/no flag that tells Helmsman whether or not the BBS is set up 
to automatically renumber its messages.  Most Second Sight BBSs do not auto-renumber their 
messages, but a few do.  If you aren't sure about a particular BBS, ask the sysop.

Read mail character is the character you type at the Mail menu to read messages.  Usually it is "R".
Send mail character is the character typed to send mail from the Mail menu.  Usually an "S" or "P" 
(for "post").
Find user name character is the character typed from the Mail menu to find a user name.  Usually an 
"F".
Read message character is the character typed to read public messages from the appropriate public 
message section menu.  Again, usually an "R".
Send message character is the character typed to send a public message from the appropriate public 
message section menu.  Quite often it's "P", occasionally it is "S".
Upload character is the character typed at the file section menu to initiate an upload.
Download character is the character typed at the file section menu to initiate a donload.
List files character is the character typed at the file section menu to list ALL files.
List new files character is the character typed at the file section menu to list NEW files.
Search files character is the character typed at the file section menu to search for files based on their 
title.  Be careful - some BBSs use a third-party utility to enable users to search based on the file 
description as well.  This isn't supported by Helmsman.

Once you've entered all these parameters, you can click on "More expert settings" to enter the 
message, text and file section listings.  The first two sections in each listing will appear as buttons to 
the side of the list in Helmsman when calling "live," so you may want to put your most-used or most 
unique sections "up front."

Make sure you save your changes, and double-check that you've entered the appropiate name, 
password and phone number in the "BBS Settings" dialog.
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Version History

Helmsman is based in large part on an earlier program of mine called Maclectic Navigator.  Maclectic 
Navigator did most of the things Helmsman does, but was limited to communicating only with 
Maclectic BBS.  Also, many things were "hard-coded" into Maclectic Navigator, so every time Bob 
Rockhill made a change to Maclectic, I had to release a new version of Maclectic Navigator.  With 
Helmsman's BBS setup documents, not only can Helmsman be easily updated be me or any user to 
respond to changes in a given BBS, but new BBS setups can be developed for virtually any Second 
Sight BBS.

Version 1.0 First official release.  August 1, 1991.  
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Credits

Portions of Helmsman are © copyright 1989 , 1990  Silicon Beach Software,, Inc.
Serial port XCMDs by Harry Chesley, © copyright 1987 Apple Computer
Other XCMDs/XFCNs:

FileExists() by Guy Kuo
NewFileName() by Andrew Gilmartin
LastPathItem() by Dwight Mayo
FileType() and ChangeFileType() by Larry Wolfarth
RenameFile and DeleteFile by Dewi Williams

All other XCMDs/XFCNs are part of the SuperCard development package.
All SuperTalk scripts © copyright 1990, 1991 by Greg Neagle
Thanks to George Shearer for his Archive handler.
Visual design © copyright 1990, 1991 by Greg Neagle
This documentation © copyright 1990, 1991 by Greg Neagle

Thanks to Bob Rockhill and Char Rice for their time and support.
Several icons, most notably the "ship" icon that identifies Helmsman on the desktop, are by Ed Lopez.

Greg Neagle America Online: GregNeagle
951 E. Greenwood #M3 GEnie:                G.Neagle
La Habra, CA 90631

I am also available on the following Southern California BBSs:

Maclectic - Bob Rockhill, sysop (213) 947-4402
The Drawing Board - Char Rice, sysop  102/885 (818) 965-6241
Glassell Park - Pete Johnson, sysop 102/863 (213) 254-4133
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